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Next couple slides compare how many 
iSeries ILE applications look today vs. what 
the typical web application looks like
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Today's ModelToday's Model

•Program puts up screen, waits for 
input
•Program processes input, does 
business logic

enter customer number:_____

Time:8:05                 date:Oct 22,2000

Enter

*PGM*PGM 5250 Screens5250 Screens

DB Access

Business
Logic

UI 
Processing

DB2/400

BufferBuffer

Data

The iSeries ILE program (e.g. RPG *PGM), performs the business logic, 
accesses program data (File I/O, or DB2 installed on iSeries for example).

PGM does UI processing, outputs UI information to a buffer. 5250 reads the 
buffer to display UI.
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RPG / COBOLRPG / COBOL

eBusiness ApplicationeBusiness Application

•JavaServer Pages (JSPs) for UI
ƒHTML tags for constant part

ƒJSP tags for dynamically substituted data

ƒHTML FORMs for user input fields

•Servlets for UI processing
•Java Bean encapsulation of business logic
•Business Logic: *PGM or ILE procedures

DB2/400

JSPsJSPs

DB Access

Business
Logic

UI 
Processing

ServletServlet

Java 
Bean

WrapperWrapper

Typical e-Business application (JSP Model 2 architecture).
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Java 

Bean or 

EJB

HTTPHTTP

HTTP HTTP 

ServerServer

•Servlet called by user or HTML FORM

•Web Server calls Servlet
ƒServlet optionally reads input fields

•Servlet instantiates Java Bean

•Java Bean gets its data
ƒFrom other Java code, DB2, RPG, whatever

•Servlet calls JSP
ƒPasses Java Bean containing data
ƒJSP merges data with HTML => new page

•HTTP Server sends new page to user

JSPJSP

ServletServlet
WebWeb--

SphereSphere

*SRVPGM*SRVPGM

*PGM*PGM

DB2DB2

JavaJava

Web ModelWeb Model

url 

request

11

22 33
44

55

66

Above is typical Model 2 JSP architecture
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JSP Model 1 architecture

Two approaches for building web applications using JSP technology- Model 
1 & Model 2. The goal of a well designed web application (or any
application) is to separate data presentation from content (or the model 
(business logic & data) from the view).

-M1 & M2 differ essentially in where the bulk of the processing is 
performed. In Model 1 the JSP alone is responsible for taking incoming 
requests and replying back to client. Results in lots of scriplets and Java 
Code in the JSP.
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JSP Model 2 architecture

It takes advantage of the predominant strengths of both 
technologies, using JSP to generate the presentation layer 
and servlets to perform process-intensive tasks (controller).

Here, the servlet acts as the controller and is in charge of 
the request processing and the creation of any beans or 
objects used by the JSP, as well as deciding, depending on 
the user's actions, which JSP page to forward the request to. 
Note particularly that there is no processing logic within the 
JSP page itself; it is simply responsible for retrieving any 
objects or beans that may have been previously created by 

the servlet, and extracting the dynamic content from that 
servlet for insertion within static templates. This approach 
typically results in the cleanest separation of presentation 

from content.
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Terms: Web ApplicationTerms: Web Application

ƒWeb App folder structure:

J2EE J2EE 
1.41.4

+Web application folder (root folder)
+JavaSource

–all non-deployed files (java)
+WebContent

–all Web files (html, jsp, gif, ...)
+META-INF

–MANIFEST.MF
+theme

– .css style sheets
+WEB-INF

–web.xml
+classes

–Java classes of this app (usually generated)
+lib

–Supporting classes and jar files

maps dependent jar files in other Web appsmaps dependent jar files in other Web apps

Web application deployment descriptor:Web application deployment descriptor:
ƒƒidentifies servlets, security, env vars, mime identifies servlets, security, env vars, mime 

types, key pages, external references and types, key pages, external references and 
session configuration infosession configuration info

collectively known as "Web collectively known as "Web 
Resources"Resources"
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Terms: WAR FilesTerms: WAR Files

ƒWeb Archive Files (WAR)
�One file containing
ƒƒWhole folder structure of Web applicationWhole folder structure of Web application
ƒƒIncluding web.xml fileIncluding web.xml file
ƒƒOptionally including sourceOptionally including source

�Used to 
ƒƒInstall and configure Web application in an application Install and configure Web application in an application 

serverserver
+Web application folder (root folder)

+JavaSource
–all non-deployed files (java)

+WebContent
–all Web files (html, jsp, gif, ...)
+META-INF

–MANIFEST.MF
+theme

– .css style sheets
+WEB-INF

–web.xml
+classes

–Java classes of this app (usually generated)
+lib

–Supporting classes and jar files

MyWebProject.war

J2EEJ2EE
1.41.4

If you want to distribute and/or deploy a Web application, you package it as 
a WAR file (similar to a .jar file used to distribute java class libraries). J2EE 
specification defines what the WAR can contain � top-level WEB-INF 
folder contains web.xml and lib, class folders.
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Terms: EAR FilesTerms: EAR Files

ƒ Enterprise Archive Files (EAR)
�One file containing:
ƒƒZero or more Web Archive (war) filesZero or more Web Archive (war) files
ƒƒZero or more EJB jar filesZero or more EJB jar files
ƒƒZero or more JCA resource adapter modules (Zero or more JCA resource adapter modules (rarrar) files) files
ƒƒA J2EE deployment descriptorA J2EE deployment descriptor

�Used to install and configure:
ƒƒAll pieces of a J2EE All pieces of a J2EE Enterprise ApplicationEnterprise Application
��Web application plus Web application plus EJBsEJBs plus EJB clientsplus EJB clients

ƒƒAll Web applications for a Web site (say)All Web applications for a Web site (say)

MyEntApp.ear

+Web application folder (root folder)
+JavaSource

– all non-deployed files (java)
+webApplication

– all Web files (html, jsp, gif, ...)
+META-INF

–MANIFEST.MF
+theme

– .css style sheets
+WEB-INF

–web.xml
+classes

–Java classes of this app (usually generated)
+lib

–Supporting classes and jar files

+Web application folder (root folder)
+JavaSource

– all non-deployed files (java)
+webApplication

– all Web files (html, jsp, gif, ...)
+META-INF

–MANIFEST.MF
+theme

– .css style sheets
+WEB-INF

–web.xml
+classes

–Java classes of this app (usually generated)
+lib

–Supporting classes and jar files

+Web application folder (root folder)
+JavaSource

– all non-deployed files (java)
+WebContent

– all Web files (html, jsp, gif, ...)
+META-INF

–MANIFEST.MF
+theme

– .css style sheets
+WEB-INF

–web.xml
+classes

–Java classes of this app (usually generated)
+lib

–Supporting classes and jar files

J2EE J2EE 
1.41.4

Publish the EAR to the app server
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ƒƒ Web projectsWeb projects
��Dynamic Web project Dynamic Web project -- Created with J2EECreated with J2EE--defined folder structure for defined folder structure for 

Web ApplicationsWeb Applications
��Superset of Java projects (so contain all Java Tool support too)Superset of Java projects (so contain all Java Tool support too)

ƒƒ Automatic creation/maintainence of web.xml fileAutomatic creation/maintainence of web.xml file

ƒƒ Editor supportEditor support
��JSP and HTML filesJSP and HTML files

��Support for creating, validating, editing with content assist, aSupport for creating, validating, editing with content assist, and nd 
debuggingdebugging

��Including WYSIWYG PageDesignerIncluding WYSIWYG PageDesigner
��Custom JSP tags (taglib) supportCustom JSP tags (taglib) support

�� Images and animationImages and animation
��Cascading Syle Sheets (CSS)Cascading Syle Sheets (CSS)
��Web Diagram EditorWeb Diagram Editor

��To visualize and change the flow of a StrutsTo visualize and change the flow of a Struts--based applicationbased application

ƒƒ WAR file import, export, and validationWAR file import, export, and validation

ƒƒ Integration with WebSphere Test Environment Integration with WebSphere Test Environment 

WDSc Web Tools At A Glance
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Web Perspective with Page DesignerWeb Perspective with Page Designer

Project Explorer

Page Designer 

Properties View 

Outline View 

Palette  
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File->New->Dynamic Web Project

Dynamic Web projects

Can contain dynamic 
J2EE resources such as 
servlets, JSP files, HTML 
files, images

Also creates an 
Enterprise Application 
(EAR) project if it does not 
already exist

�Specify project name
�Servlet 2.4 = J2EE 1.4
�Select Target Server
�Automatically associates with 
a supplied EAR file for easy 
auto config of Application 
Server.

Click Next

�Special type of project
�Created with J2EE 
folder layout
�Created with simple 
web.xml file
ƒƒAutomatically updated as Automatically updated as 
resources are createdresources are created
ƒƒHas specialized web.xml Has specialized web.xml 
editoreditor
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Dynamic Web projects

Optionally creates 
a CSS style for 
whole Web app

Add iSeries Web 
Components Tag 
Library

Add Struts 
feature

Add Web 
Diagram feature

After 
creation

ƒIn Dynamic Web Project:
ƒJavaSource

ƒfor Java classes and resources
ƒWebContent

ƒfor deployed files
ƒ.jsps and .html files go here

ƒ.../theme
ƒfor style sheets

ƒ../WEB-INF
ƒrun-time dependencies
ƒjar files go here 
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Wizard to help create iSeries Wizard to help create iSeries 
RPG/COBOL web applicationsRPG/COBOL web applications

To build a Web interaction from iSeries To build a Web interaction from iSeries 
RPG/COBOL business logic, or with Java RPG/COBOL business logic, or with Java 
bean methodsbean methods
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A Web InteractionA Web Interaction

InputInput
PagePage

OutputOutput
PagePage

*PGM *PGM 
OROR

*SRVPGM*SRVPGM

InputInput
ParametersParameters

OutputOutput
ParametersParameters
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Build simple interactionBuild simple interaction

RPG Program
to access  data

WAS 
jsp
Servlet

R
e
q
u
e
s
t

R
e

s
p

o
n

s
e
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Web Interaction WizardWeb Interaction Wizard

ƒƒYou define the parameters to a *PGM/*SRVPGM, You define the parameters to a *PGM/*SRVPGM, 
wizard generates input JSP prompting for input wizard generates input JSP prompting for input parmparm, , 
output JSP showing output output JSP showing output parmsparms, and all the glue in, and all the glue in--
betweenbetween
ƒƒOr you provide the input and/or output pages, and map Or you provide the input and/or output pages, and map 
the input/output fields on the pages to the input/output the input/output fields on the pages to the input/output 
parameters in the *PGM/*SRVPGM, and it generates parameters in the *PGM/*SRVPGM, and it generates 
the glue to bind themthe glue to bind them
ƒƒCan optionally define message handling for Web Can optionally define message handling for Web 
pages, and specify flow control of pagespages, and specify flow control of pages
ƒƒSTRUTS based applicationSTRUTS based application
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Define Runtime configurationDefine Runtime configuration
To specify the authentication typesTo specify the authentication types
�� Sign on with specified values (server Sign on with specified values (server 
name, user ID, password)name, user ID, password)
�� Prompt for user ID and passwordPrompt for user ID and password
�� JCA connection (Advanced Edition)JCA connection (Advanced Edition)
�� Single Sign On (Advanced Edition)Single Sign On (Advanced Edition)
Library list setup Library list setup 
Initial command when sign onInitial command when sign on
Display detailed runDisplay detailed run--time errorstime errors
Session timeout optionsSession timeout options
Message HandlingMessage Handling

•The J2EE Connector architecture provides 
a Java technology solution to the problem 
of connectivity between the many 
application servers and enterprise 
information systems (e.g. iSeries host).
•Single sign-on (SSO)  - Only prompted to 
signon once across multiple Web 
applications. It is a mechanism whereby a 
single action of user authentication and 
authorization to a given server can permit a 
user to access all computers and systems 
where he has access permission, without 
the need to enter multiple passwords. 
Single sign-on reduces human error, a 
major component of systems failure and is 
therefore highly desirable but difficult to 
i l t
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iSeries AD, IBM Toronto iSeries AD, IBM Toronto iSeries Web componentsiSeries Web components

�Web UI components that allow 
visualization in Page Designer
�With iSeries built-in features
�Allows typical iSeries data 
formatting, e.g. edit code, edit 
word
�Table with Subfile capabilities to 
display a list of records from an 
iSeries database

•WC’s implemented as VCT’s so can be used in Page designers and 
viewed/edited in one of 3 views (design/source/preview)

•Formatting and validation defined for the WC in attribute view (e.g. format 
data as a date, numeric, currency etc. and specify that locale sensitive 
information, e.g.  decimal symbol, currency symbol, to come from either the 
web client or the iSeries host defined in web.xml)
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To create a WebTo create a Web--based frontbased front--end customer end customer 
inquiry application that uses RPG business inquiry application that uses RPG business 
logic residing on an iSeries serverlogic residing on an iSeries server

Create or reuse RPG programCreate or reuse RPG program
Create a Dynamic Web projectCreate a Dynamic Web project
Create Runtime configurationCreate Runtime configuration
Design with Web Diagram EditorDesign with Web Diagram Editor
Design a Web pageDesign a Web page
Create Web InteractionCreate Web Interaction
Test Run the Web ApplicationTest Run the Web Application
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iSeries AD, IBM Toronto iSeries AD, IBM Toronto RPG ProgramRPG Program
NOTE: Parameters to be passed

custnoi is customer number

cstruc is customer informaton

feedback is program return code
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To create a WebTo create a Web--based frontbased front--end customer end customer 
inquiry application that uses RPG business inquiry application that uses RPG business 
logic residing on an iSeries serverlogic residing on an iSeries server

Create or reuse RPG programCreate or reuse RPG program
Create a Dynamic Web projectCreate a Dynamic Web project
Create Runtime configurationCreate Runtime configuration
Design with Web Diagram EditorDesign with Web Diagram Editor
Design a Web pageDesign a Web page
Create Web InteractionCreate Web Interaction
Test Run the Web ApplicationTest Run the Web Application
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Create a Dynamic Web projectCreate a Dynamic Web project

Click Next

File > New > Dynamic Web Project

Enter “MyWebProject” as 
the project name in Name

�Servlet 2.4 = J2EE 1.4
�Servlet 2.3 = J2EE 1.3
�Servlet 2.2 = J2EE 1.2

creates an Enterprise Application 
(EAR) project if it does not already 
exist
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Create a Dynamic Web ProjectCreate a Dynamic Web Project

••Select Select StrutsStruts
••Select Select iSeries Web Components Tag LibraryiSeries Web Components Tag Library

Click 
Finish

•Select Struts for a Struts-based application

•Select iSeries Web Component Tag Library to add the tag library to the 
project



IBM Software Group Toronto Laboratory

Web Tools for iSeries developers                                September 2005 © 2005 IBM Corporation

iSeries AD, IBM Toronto iSeries AD, IBM Toronto Using iSeries Web ToolsUsing iSeries Web Tools

To create a WebTo create a Web--based frontbased front--end customer end customer 
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Create or reuse RPG programCreate or reuse RPG program
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Design with Web Diagram EditorDesign with Web Diagram Editor
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Runtime Configuration WizardRuntime Configuration Wizard

�� Select the project Select the project 
““MyWebProjectMyWebProject” in ” in Project Project 
ExplorerExplorer

�� Click Runtime Configuration iconClick Runtime Configuration icon

�Enter the name of the server that has the 
program or procedure in Host name
�Enter your user ID in User ID

Click Next

JCA Connector and Single Signon are available in advanced version.
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Runtime Configuration WizardRuntime Configuration Wizard

•Add any runtime library that are required 
to run the host program or procedure

•Enter library “wsslabxx” in Library
•Click Add

•Select Display detailed run-time errors

Click Finish
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Create or reuse RPG programCreate or reuse RPG program
Create a Dynamic Web projectCreate a Dynamic Web project
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Design with Web Diagram EditorDesign with Web Diagram Editor
Design a Web pageDesign a Web page
Create Web InteractionCreate Web Interaction
Test Run the Web ApplicationTest Run the Web Application
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Web Diagram EditorWeb Diagram Editor

Double click Web Diagram 
inside your Web project to open 
the Web Diagram Editor

Web Diagram 
Editor

Web Diagram 
Palette

A Web diagram helps you to design the flow of a Web application. It
consists of nodes and connections between nodes. A node is an icon 
that represents a resource such as a Web page, Java bean. 
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iSeries AD, IBM Toronto iSeries AD, IBM Toronto 
Web Diagram EditorWeb Diagram Editor

Drag and drop Web Page node onto 
the Web Diagram Editor
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Web Diagram EditorWeb Diagram Editor

Change the name of the Web page 
to “custInquiryInput.jsp”



IBM Software Group Toronto Laboratory

Web Tools for iSeries developers                                September 2005 © 2005 IBM Corporation

iSeries AD, IBM Toronto iSeries AD, IBM Toronto 
Web Diagram EditorWeb Diagram Editor

•Drop a second Web Page node and name it as “custInquiryOutput.jsp”
•Then drag and drop a Web Interaction Action Mapping node to represent the 
interaction, and name it as “custInquiry”

�if the resource does not 
exist, the node is called 
unrealized, shown as gray 
icons
�If the resource exists, 
the node is called 
realized, shown as 
colored icons
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Web Diagram EditorWeb Diagram Editor

•Right click on custInquiryInput node, select Connection
•Draw a connection line from custInquiryInput node to custInquiry node
•Right click on custInquiry node, select Connection
•Draw a connection line from custInquiry node to custInquiryOutput node
•Give a name “success” to the local forward connection
•A local forward connection represents the possibility that this action can go to a new 
destination, “custInquiryOutput.jsp” through a forward
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iSeries AD, IBM Toronto iSeries AD, IBM Toronto Using iSeries Web ToolsUsing iSeries Web Tools

To create a WebTo create a Web--based frontbased front--end customer end customer 
inquiry application that uses RPG business inquiry application that uses RPG business 
logic residing on an iSeries serverlogic residing on an iSeries server

Create or reuse RPG programCreate or reuse RPG program
Create a Dynamic Web projectCreate a Dynamic Web project
Create Runtime configurationCreate Runtime configuration
Design with Web Diagram EditorDesign with Web Diagram Editor
Design a Web pageDesign a Web page
Create Web InteractionCreate Web Interaction
Test Run the Web ApplicationTest Run the Web Application
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iSeries AD, IBM Toronto iSeries AD, IBM Toronto Create Web PageCreate Web Page

�Double click on custInquiryInput
node

�New JSP File dialog will appear, 
the File Name is pre-filled with 
the name of the node

�Click Finish
Click Finish
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�� MyJspPageMyJspPage is created and is is created and is 
opened in the Page Designeropened in the Page Designer

�� Tools > Tools > WebArtWebArt Designer to launch Designer to launch 
the the WebArtWebArt Designer to design a Designer to design a 
logologo



IBM Software Group Toronto Laboratory

Web Tools for iSeries developers                                September 2005 © 2005 IBM Corporation

iSeries AD, IBM Toronto iSeries AD, IBM Toronto 
WebArt Designer

� Wizards for Logo/Button/PhotoFrame/Rollover

� Supports MIF, GIF, JPEG, PNG, Bitmap, Windows Metafile, TIFF, FlashPix, 
Photo CD file types

•WebArt Designer assists you in creating, manipulating, and editing graphics 
and image files that you can import to Page Designer.

•Use this application to edit the color tone and contrast of imported 
photographs
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WebArt Designer

•Object > Create Logo
•Logo Wizard opens
•Enter “My Company” in Text
•Change Font name to “Comic Sans 
MS”
•Change Font size to “48”
•Select Bold
•Select Italic
•Select Center
•Click Next

Click Next

To create a logo
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�� Select theseSelect these

Click Next

�� Select Select SealSeal
�� Click Click Edge colorEdge color
�� Select blue colorSelect blue color
�� Click Click OKOK
�� Click Click NextNext
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�� Select Select EmbossEmboss
�� Click Click FinishFinish

Click Finish
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�� Select the logo object on the Select the logo object on the 
canvascanvas

�� Click Click File > Save Wizard for File > Save Wizard for 
WebWeb

�� Select Select Save the selected Save the selected 
objectsobjects

�� Click Click NextNext

Click Next
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�� Select Select GIFGIF
�� Click Click NextNext
�� Click Click FinishFinish
�� Save to Save to 

MyCompanyLogo.gifMyCompanyLogo.gif

Click Next
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�� Copy Copy MyCompanyLogo.gifMyCompanyLogo.gif from your from your 
file system to file system to 
MyWebProject/WebContentMyWebProject/WebContent

�� Delete the text “Place content here”Delete the text “Place content here”
�� Drag and drop Drag and drop MyCompanyLogo.gifMyCompanyLogo.gif

to the canvasto the canvas
�� Place cursor under the logoPlace cursor under the logo
�� Select Select Heading 1Heading 1 from drop downfrom drop down
�� Type “Customer Inquiry”Type “Customer Inquiry”
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�� Drag and drop Drag and drop Form Form from from iSeries iSeries 
Web Components Web Components drawer to a drawer to a 
location under the page headinglocation under the page heading

�� A dialog will appear, click A dialog will appear, click YesYes

•When you create a JSP page, the default workbench encoding is used for 
the page. 

•When you insert an iSeries Web Component the very first time, it will 
prompt you this message, “It is recommended to use UTF-8 for encoding. 
Do you want to change it?”

•By selecting Yes will change the page encoding and the charset values to 
UTF-8.

•UTF-8 encoding enables you to have globalization support in your Web
application.
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�� Drag and drop Drag and drop Simple Table Simple Table onto the form onto the form 
to insert a table for alignmentto insert a table for alignment

�� A dialog will appear, select the button in A dialog will appear, select the button in 
the centre of the centre of Apply patternApply pattern

�� click click OKOK

•The button in the centre of Apply pattern means no border for the table, 
that is the table is invisible.
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�� Drag and drop Drag and drop Label Label onto row 1 onto row 1 
column 1 of the tablecolumn 1 of the table

�� Type “Customer Number:” in Type “Customer Number:” in 
properties viewproperties view

•As you enter the Initial Value field, the value is shown on the Page 
Designer right away.
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�� Drop Drop Text Entry Text Entry onto row onto row 
1 column 2 of the table1 column 2 of the table

�� Drop Drop Button Button onto row 2 onto row 2 
column 1 of the tablecolumn 1 of the table

�� Type “Submit” in Type “Submit” in LabelLabel
�� Save the fileSave the file
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To create a WebTo create a Web--based frontbased front--end customer end customer 
inquiry application that uses RPG business inquiry application that uses RPG business 
logic residing on an iSeries serverlogic residing on an iSeries server

Create or reuse RPG programCreate or reuse RPG program
Create a Dynamic Web projectCreate a Dynamic Web project
Create Runtime configurationCreate Runtime configuration
Design with Web Diagram EditorDesign with Web Diagram Editor
Design a Web pageDesign a Web page
Create Web InteractionCreate Web Interaction
Test Run the Web ApplicationTest Run the Web Application
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Web Interaction WizardWeb Interaction Wizard

•Double click on custInquiry node to 
open Web Interaction wizard
•Note: custInquiryInput.jsp node is now 
shown as color for it is realized
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Web Interaction WizardWeb Interaction Wizard

The Web Interaction 
name is pre-filled with 
“custInquiry”

Click Next
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Web Interaction WizardWeb Interaction Wizard

Click Next

�Use input pages option 
is pre-selected and 
shows existing page 
custInquiryInput. 

�Generate output 
pages option is pre-
selected and shows page 
to be generated 
custInquiryOutput.jsp

To define input and output pages.

2 modes:

•Let wizard to generate the Web pages for you

•You specify existing pages

You can specify multiple output pages or the wizard can generate multiple 
output pages for you.

Select Generate input/output pages using a page template allows you to 
provide a page template, and the wizard will generate Web pages using the 
specified page template. This open is only available if Generate input page
or Generate output pages is selected
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Web Interaction WizardWeb Interaction Wizard

Describe program / procedureDescribe program / procedure

1a

•Click Import PCML, the Import PCML dialog will be 
opened
•Select Remote/Local File System from Select PCML 
file from drop down list

•To identify the host program or Java bean to call for each interaction.

•You can import the definitions from a program source

•you can also specify program and parameter definitions manually if you do 
not have the source

•Or you can import a pcml file if it has already been generated by the 
RPG/COBOL compiler or Program Verifier
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Web Interaction WizardWeb Interaction Wizard

1a

•Add a connection if it does not 
already exist
•Expand the connection
•Enter Password dialog 
appears
•Enter your user ID and 
password
•Click OK

Look up the program source from the host
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Web Interaction WizardWeb Interaction Wizard

1a

•Right click on the connection
•Select Properties, Properties 
dialog appears
•Select Subsystems on the left 
pane
•Select iSeries Commands tab
•Enter library “wsslabxx” in 
Library
•Click Add
•Click OK
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Web Interaction WizardWeb Interaction Wizard

1a •Expand *LIBL
•Expand “wsslabxx”
•Locate the program source 
/QRPGLESRC.FILE/GETDATA.R
PGLE
•Click OK

Can also import PCML, or import iSeries ILE source
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Web Interaction WizardWeb Interaction Wizard

1a

•Click Select All
•Click OK

A tree representation of program and parameter relationship

CSTRUC is a structure

GETDATA is a program 

The tree of the right shows all the fields in the structure and the program.
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Web Interaction WizardWeb Interaction Wizard

1a

•Select GETDATA on the left 
pane, the program info is 
displayed on the right
•Select Associate this 
program with the 
interaction
•Click OK

Describe programDescribe program
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Web Interaction WizardWeb Interaction Wizard

1a •Select CUSTNOI, the 
parameter info is display on 
the right
•Change Usage to input for 
input parameter
•Click OK

Describe parameterDescribe parameter

ƒƒInput:Input: read by programread by program
ƒƒOutput:Output: updated by updated by 

programprogram
ƒƒInput/Output:Input/Output: bothboth

Parameters imported from source are all default to “input/output” usage 
type.
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Web Interaction WizardWeb Interaction Wizard

1a •Select CSTRUC, the 
parameter info is display on 
the right
•Change Usage to output for 
output parameter
•Click OK

Describe parameterDescribe parameter

Click Next

CSTRUC is a structure
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Web Interaction WizardWeb Interaction Wizard

1a

• Select TEXTENTRY1 on the 
left
•Select CUSTNOI on the right
•Click Link
•Click Next

Map fields in Web Map fields in Web 
page to input page to input 
parametersparameters

Click Next

•The input page is created by user, the wizard has no clue of which field is 
for which parameter, so field mappings are required

•TEXTENTRY1 is the name of the text entry field for Customer Number in 
custInquiryInput.jsp, it is mapped to CUSTNOI input parameter

•When the Web application is run, data from this TEXTENTRY1 field will 
be passed to the RPG program as input parameter, and the host program will 
process it and return the data in the output parameters.
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Web Interaction WizardWeb Interaction Wizard

Tailor attributes of Tailor attributes of 
overall input pageoverall input page

Tailor Tailor 
attributes of attributes of 
generated generated 
prompt per prompt per 
parameterparameter

Click 
Finish

��Preview of generated Preview of generated 
output page. output page. 
��Immediately see Immediately see 
results of tailoring results of tailoring 
parameter and page parameter and page 
attributesattributes

Select output parameters Select output parameters 
to display in output pageto display in output page

Page Tab – allows you change the page title, background color of the page,
and title color

Fields Tab – allows you to the label, web component type, size of each field
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Web Diagram EditorWeb Diagram Editor

After the wizard generates the After the wizard generates the 
Web pages, Java Action Web pages, Java Action 
classes, icons are classes, icons are realized realized and and 
are shown as coloredare shown as colored
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Web Interaction WizardWeb Interaction Wizard

Files that are generated by Files that are generated by 
the wizard: the wizard: Java classes, Java classes, 
properties files, JSP files, properties files, JSP files, 
JavaScript files,  PCML fileJavaScript files,  PCML file

.wit file is generated per .wit file is generated per 
interaction for roundinteraction for round--
tripping purpose. tripping purpose. 

You can double click on custInquiry.wit to reopen the Web Interaction 
wizard with custInquiry interaction information. 
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What's Next?What's Next?

�What did you do so far?
ƒCreated a Dynamic Web project
ƒSet runtime configuration to call your RPG Program 

remotely
ƒDesign your Web application using Web Diagram 

Editor
ƒDesign your input page
ƒCreated an 'iSeries Web Interaction' to link your RPG 

program parameters to the input page and output page
ƒThe input page was created by you
ƒThe output page was generated for you

�Next?
ƒRun locally to test your application Or
ƒPublish all your files to the iSeries server

iSeries AD, IBM Toronto iSeries AD, IBM Toronto 
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To create a WebTo create a Web--based frontbased front--end customer end customer 
inquiry application that uses RPG business inquiry application that uses RPG business 
logic residing on an iSeries serverlogic residing on an iSeries server

Create or reuse RPG programCreate or reuse RPG program
Create a Dynamic Web projectCreate a Dynamic Web project
Create Runtime configurationCreate Runtime configuration
Design with Web Diagram EditorDesign with Web Diagram Editor
Design a Web pageDesign a Web page
Create Web InteractionCreate Web Interaction
Test Run the Web ApplicationTest Run the Web Application
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WDSc: Run On ServerWDSc: Run On Server

ƒRun On Server
�Now this is VERY COOL!

ƒWhen ready to test your Web app
�Right click on initial html or jsp file
ƒƒor whole project, which implies the index.html fileor whole project, which implies the index.html file

�Select "Run on Server"
�Wait for the magic...

ƒYour Web application will run!
�Opens Server perspective
ƒƒPublishes it to the builtPublishes it to the built--in copy of WAS (and starts WAS)in copy of WAS (and starts WAS)
ƒƒBrings up a Web BrowserBrings up a Web Browser
ƒƒRuns your application!! Runs your application!! 
��Tip: you can set breakpoints in your Java code! Tip: you can set breakpoints in your Java code! 
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A local copy of WAS 6.0 Single Server Edition
is embedded in the IDE

ƒƒIntegrated with Server Tools to enable instant and Integrated with Server Tools to enable instant and 
deaddead--easy testing of Web projects, EJB projects, easy testing of Web projects, EJB projects, 
Enterprise Application projects within WDSc.Enterprise Application projects within WDSc.
ƒƒSupports configuring multiple Web applications Supports configuring multiple Web applications 
ƒƒSupports multiple servers that can be configured and Supports multiple servers that can be configured and 

run at the same time run at the same time 
ƒƒProvides access to the WAS Administration Console Provides access to the WAS Administration Console 

WebSphere Test Environment

Can create a server instance for deploying e.g. EAR 1-5, another for EAR 1-
4

Can create a server instance for deploying with security configuration “1”, 
another for security configuration “2”
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••Right click on the initial Right click on the initial 
HTML or JSP file, HTML or JSP file, 
custInquiryInput.jspcustInquiryInput.jsp
••Run > Run on ServerRun > Run on Server
••Select WAS v6.0, click FinishSelect WAS v6.0, click Finish

You can select to test run on other versions of WAS if they are installed.
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Testing the InteractionTesting the Interaction

Input page in Input page in 
the builtthe built--in in 

browserbrowser

Console entries can be Console entries can be 
viewed in console viewviewed in console view

•Enter “0010100” for Customer 
Numer
•Click Submit
•The action that is associated with 
this Submit button will invoke the 
RPG program, which will return 
customer data in the output 
parameter CSTRUC1 and display 
it on the output page
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Testing the Interaction Testing the Interaction 

��Application fetched Application fetched 
data from database data from database 
��Output page in the Output page in the 
builtbuilt--in browser.in browser.
��Use Page Designer to Use Page Designer to 
finesse generated finesse generated 
pagespages

You can customize the generated output page using the Page Designer.
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AGENDAAGENDA

ee--business Primerbusiness Primer
AD Model, traditional
e-Business Application, Web Model

Introducing Web Tools for iSeriesIntroducing Web Tools for iSeries
J2EE Enterprise Application
Web Tools At A Glance
Dynamic Web Project
Web Interaction wizards
Runtime Configuration wizard
iSeries Web Components

Demo: Using iSeries Web ToolsDemo: Using iSeries Web Tools

Advanced TopicsAdvanced Topics
Mixing Java with RPGMixing Java with RPG
StrutsStruts

iSeries AD, IBM Toronto iSeries AD, IBM Toronto 
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FCUSTOML3  IF   E           K DISK   
DCUSTINFO         DS                 
D Number                  1      7A    
D Name                    8     47A    
C     *ENTRY      PLIST     
C                 PARM              CUSTINFO
C     Number      SETLL    CUSTOM01         
C     Number      READE    CUSTOM01             9091
C                 EVAL     Name = CUSTNA            
C                 MOVE     *ON          *INLR       
**************** End of data ************************ 

Say we have the following RPG code . . .

Pass in Customer ID and receive back customer name.

Java Calling RPGJava Calling RPG

F-spec defines the database File containing customer information records

D-spec defines data structure CUSTINFO, containing two fields, Name, 
Number. 

C-spec defines one parameter, the struct- type inputoutput
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<pcml version="1.0">

<!-- Create a Data Structure -->
<struct name="custinfo">

<data name="Number" type="char" length="7"
usage="inputoutput" init="0014400"> </data>

<data name="Name" type="char" length="40"
usage="inputoutput" init=" "> </data>

</struct>

<!-- Program getcust -->
<program name="getcust"

path="/QSYS.lib/FARR.lib/GETCUST.pgm">
<data name="gotback" type="struct"

usage="inputoutput" struct="custinfo"> </data>
</program>

</pcml>

Create XML required tagsCreate XML required tags
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public static void main(String[] argv)
{

AS400 as400System = new AS400();
ProgramCallDocument pcml = null;
String msgId, msgText;
Object value = null;

try {
System.out.println(

"Creating ProgramCallDocument for GetCust pgm.");
pcml = new ProgramCallDocument(as400System, "GETCUST");
boolean ok = pcml.callProgram("getcust");
System.out.println(" rc is---> " + ok);
if (!ok)
{ /* Retrieve list of AS/400 messages & display them */ }

else
{

value = pcml.getValue("getcust.gotback.Name");
System.out.println("Customer name: " + value);

}
} catch (PcmlException exc) {
System.out.println("*** Call to getcust failed. ***");
System.exit(0);

}
System.exit(0);

} // end main method

Call RPG from Java ApplicationCall RPG from Java Application

File: GetCust.javaFile: GetCust.java

Class: GetCustClass: GetCust

Toolbox classes used for making program calls.
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f:\toolbox\examples>javac GetCust.java

f:\toolbox\examples>java GetCust

Constructing ProgramCallDocument for GetCust pgm...

rc is---> true

Customer name: Great Neck Industries

f:\toolbox\examples>

Command Prompt x

Mixing Java and RPG Mixing Java and RPG 
Results . . .
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AGENDAAGENDA

ee--business Primerbusiness Primer
AD Model, traditional
e-Business Application, Web Model

Introducing Web Tools for iSeriesIntroducing Web Tools for iSeries
J2EE Enterprise Application
Web Tools At A Glance
Dynamic Web Project
Web Interaction wizards
Runtime Configuration wizard
iSeries Web Components

Demo: Using iSeries Web ToolsDemo: Using iSeries Web Tools

Advanced TopicsAdvanced Topics
Mixing Java with RPGMixing Java with RPG
StrutsStruts

iSeries AD, IBM Toronto iSeries AD, IBM Toronto 
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StrutsStruts

Web Interactions are Struts based!Web Interactions are Struts based!
Struts environmentStruts environment
Simple Struts applicationSimple Struts application
iSeries Interaction and Struts iSeries Interaction and Struts 
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Web Wizard Struts based ...Web Wizard Struts based ...

Model

Controller

View

Struts 
Framework

M.V.C

Logic! 
JSPs & HTML

Traffic Controller

What is Struts? A development framework for Java servlet
applications based upon the Model-View-Controller (MVC) 
design paradigm.
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Simple Struts web applicationSimple Struts web application

�Determine weekday from date

�One input page

�Two different 

Output pages 

Struts-config file 
<action-mappings>
<action name="formBean" path="/computeDay" 

scope="request" 
type="com.ibm.dayofweek.actions.ComputeDayAction" 
input="index1.jsp">

<forward name="success" path="/output.jsp">
</forward>
<forward name="failure" path="/index1.jsp">
</forward> 
<forward name="sunday" path="/output_sunday.jsp">
</forward> 
</action>
</action-mappings>
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Struts = MVC design = Model 2Struts = MVC design = Model 2

•the Struts “action” servlet acts as a common controller for the 
whole application

•Model includes Action classes, Form Beans

•The web.xml file contains: the definition of the Struts servlet
named "ActionServlet“, the URL mapping for the calls to this 
servlet (*.do)



IBM Software Group Toronto Laboratory

Web Tools for iSeries developers                                September 2005 © 2005 IBM Corporation

JSP Model 2 architecture

It takes advantage of the predominant strengths of both 
technologies, using JSP to generate the presentation layer 
and servlets to perform process-intensive tasks (controller).

Here, the servlet acts as the controller and is in charge of 
the request processing and the creation of any beans or 
objects used by the JSP, as well as deciding, depending on 
the user's actions, which JSP page to forward the request to. 
Note particularly that there is no processing logic within the 
JSP page itself; it is simply responsible for retrieving any 
objects or beans that may have been previously created by 

the servlet, and extracting the dynamic content from that 
servlet for insertion within static templates. This approach 
typically results in the cleanest separation of presentation 

from content.
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What the “action” What the “action” servletservlet doesdoes

a. Automatically transfers 
data from your form into 
a JavaBean
(ActionForm)

b. Calls the Action class 
you specify. This class 
may use the data in the 
ActionForm bean. When 
this class finishes it 
returns control to the 
ActionServlet, passing it 
a “forward”- as defined 
in the struts-config.xml-
the next page to be 
displayed in the 
browser.
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Struts web.xml entries…Struts web.xml entries…

<servlet-name>action</servlet-name>      

<servlet-class> org.apache.struts.action.ActionServlet </servlet-class> 

<servlet-mapping>

<servlet-name>action</servlet-name>

<url-pattern>*.do</url-pattern>

</servlet-mapping>

•the Struts “action” servlet acts as a common controller for the 
whole application

•Model includes Action classes, Form Beans

•The web.xml file contains: the definition of the Struts servlet
named "ActionServlet“, the URL mapping for the calls to this 
servlet (*.do)
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strutsstruts--config.xmlconfig.xml entries …entries …

<form-beans>

<form-bean name="submitForm"

type="myPackage.SubmitForm"/>

</form-beans>

<action-mappings>

<action path="/submit"

type="myPackage.SubmitAction"

name="submitForm"

scope="request">

<forward name="success" path="/submit.jsp"/>          

<forward name="failure" path="/submit.jsp"/>          

</action>

</action-mappings>

path - name of the request: "submit.do". You don't 
enter the ".do"-part here.

type - the path for the Action class file

name - is the logical name of the form bean (from 
the form-bean section)

input - validation errors should be shown on this 
page

forward- tag tells the “action” servlet where to go if 
it receives either "success" or "failure" from the 
Action class. 
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Form bean Form bean 
Contains values Contains values 
from formsfrom forms

Input pageInput page
Form for Form for 
data inputdata input

Output pageOutput page

Action Action 
Invoke logic Invoke logic 
Provide forward info to choose which page gets shown next Provide forward info to choose which page gets shown next 

Timeout page, displayed Timeout page, displayed 
when session is timed outwhen session is timed out

Logon page is only displayed Logon page is only displayed 
when Prompt for when Prompt for signonsignon is is 
selected for authenticationselected for authentication

Error page is displayed only Error page is displayed only 
when runtime error occurswhen runtime error occurs

Change password page is displayed only Change password page is displayed only 
when password of the server has expiredwhen password of the server has expired

After Web Interaction wizard generates all the classes, SP files and 
connections, you can drop the initial JSP page (custInquiryInput.jsp) onto 
the web diagram and right click > Draw All, then the entire flow of the 
application is drawn for you. These information are based on struts-
config.xml.
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More Information?More Information?

ƒInformation Sources
www-306.ibm.com/software/awdtools/iseries
ƒƒFor iSeries Applicaton DevelopmentFor iSeries Applicaton Development

www.eclipse.org
ƒƒEclipse and information about eclipseEclipse and information about eclipse

www.ibm.com/software/info1/websphere/partners/iseries.jsp
ƒƒWebSphere on iSeries home page for BPsWebSphere on iSeries home page for BPs

eServer magazine (iSeries edition)
ƒƒArticles on WDScArticles on WDSc
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there is no guarantee that the same or similar results will result elsewhere. 
Customers attempting to adapt these techniques to their own environment do so at 
their own risk.
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All customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved.  Actual environmental 
costs and performance characteristics may vary by customer.
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Photographs shown are of engineering prototypes.  Changes may be incorporated in production models.
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